
C h a p t e r 7
 

Solid Problem Six 
 

 
In this chapter, you will learn the following to World Class standards: 

 
 Sketch of Solid Problem Six 
 Starting a 3D part drawing 
 Modifying UCS settings 
 Constructing a solid perimeter using the Line command 
 Adding a circle to the detail 
 Trimming the circle and erasing extra line 
 Creating polylines using the Edit Polyline tool 
 Drawing a closed polyline shape to be extruded 
 Extruding a solid from closed polylines 
 Rotating a 3D solid using the 3D Rotate command 
 Aligning 3D solids using the Align command 
 Union of the solids 
 Hiding the solid 
 Moving the solid to the origin point 
 Saving the solid problem
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Sketch of Solid Problem Six 
________________________________________________________ 
 
You start the sixth solids problem with a rough sketch showing the dimensions of each detail. 
This part is not symmetrical. In this exercise, you will draw lines, add a circle, and trim away 
construction lines to create a complex shape. Then you will convert the outline to a closed 
polyline.  Next, you will draw a closed Polyline containing just line segments. After extruding 
the two polylines, you will align the two shapes together and combine them into one solid 
using Union. Your three dimensional drawing will appear as shown in Figure 7.1. 
 

 
Figure 7.1 – Problem Six sketch
 
By this point in your 3D training, you should be comfortable with interpreting an isometric 
sketch. When you receive a sketch from a professional, quickly identify the different shapes 
and decide how to begin your drawing. Problem six has two different complex shapes to be 
drawn and brought together.  You will be learning about the Align command in this problem, 
which will both move and rotate a solid simultaneously. All of the drills in the Fundamentals 
of 3D Drawing textbook will walk you through such common repetitive maneuvers that you 
will use often in 3D modeling. 
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Starting a 3D Part Drawing 
________________________________________________________ 
 

You will draw Problem Six using the Metric template.  First select the New tool on 
the Quick Access Toolbar. A list of templates is loaded in the “Select template” 
window.  Scroll down the list and select Metric.dwt. A new drawing file will open 
that contains the system variables and layer definitions which you will use later in 
Paper Space to finish the drawing. 

 

 

 
 

Figure 7.2 – Starting the drawing using the Metric template 
 
 
 

Modifying UCS Settings 
________________________________________________________ 
 
You may notice the UCS icon moving on the graphical display as you zoom or pan your view.  
If so, the UCS is currently representing the origin (0,0,0) of the drawing area.  This can 
sometimes be distracting, especially if the origin happens to lie in the vicinity of your 
drawing.  You can change the UCS settings so that the icon is always displayed in the bottom 
left-hand corner of the drawing area. Select the Show UCS Icon tool from the Coordinates 
panel under the Home tab (Figure 7.3) and select the “Show UCS Icon” option (Figure 7.4). 
You also have the choice of keeping the UCS displayed at the origin or turning it off 
completely.    
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Figure 7.3  -  The Coordinates panel Figure 7.4  -  Changing the UCS display 

settings 
  

 
 

Constructing a Solid Perimeter Using the Line Command 
________________________________________________________ 
 

To begin you need to assemble a shape using the Line command. Select the Line tool 
from the Draw panel.  Select a point in the lower right side of the graphical display. 
Toggle the Ortho mode to On to keep lines perfectly horizontal or vertical.   
  

Move the cursor to the right and type “40” 
and ENTER at the keyboard.  To draw the 
vertical line next, move the cursor upward 
and type “30” and ENTER.  Now move the 
cursor to the left and type “50” and ENTER.  
For the fourth line, move the cursor down and 
type “10” and ENTER. Next, move the cursor 
back to the right and type “10” and ENTER. 
To close this shape, just type “C” and 
ENTER. 

 
Figure 7.5 – Drawing a series of lines
 
Here you used the line command as opposed to the polyline command so that you can add an 
additional detail to the perimeter using the Circle tool.  You will create the finished outline 
into a polyline using the Edit Polyline tool.   
 
 
 

Adding Circles to the Detail 
________________________________________________________ 
 
Adding a circle as opposed to an arc makes the problem easier for you because the arc 
tool is rather complex. Many computer aided designers learn to draw circles and trim 
out unwanted sections to create arcs. 
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Select the Circle command from the Draw 
panel under the Home tab.  Select the 
midpoint Osnap of the bottom side of the 
shape as the center point of the circle.  Type 
“10” and ENTER when the command line 
prompts you with “specify radius of circle”. 
You have placed the arc as shown in the 
sketch, and now you only need to trim away 
the other half of the circle and the horizontal 
line away to finish the detail of this 
perimeter.   

  

Figure 7.6 –Adding a circle to the solid 
 
 
 

Trim the Circle and the Extra Line 
________________________________________________________ 
 
Now you need to remove the line segment passing through the circle and the outside 
arc segment of the circle to create a box with a half circle inscribed.  
 

Select the Trim command on the Modify 
panel and hit ENTER to automatically select 
all lines on the screen as cutting lines. Select 
the line segment passing through the circle 
and the outside arc segment of the circle so 
that the drawing appears as shown in Figure 
7.7. This shape now contains eight entities: 
seven line segments and one arc segment. 
You can only extrude the shape after bringing 
all eight components together using the Edit 
Polyline tool. 

  

Figure 7.7 –The trimmed circle  
 
 
 

Creating Polylines Using the Edit Polyline Tool 
________________________________________________________ 

 
Select the Edit Polyline tool from the drop-down arrow on the Modify panel and the 
command line will prompt you to “Select polyline or [Multiple]:” Select one of the 
lines of the perimeter and the command line will reply with “Object selected is not a 
polyline Do you want to turn it into one? <Y>”.  Type Y and ENTER, and then the 
command line will prompt you with a number of editing options from which to choose.  
Type “J” and ENTER to choose the Join option.   
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The command line will prompt you to “Select 
objects” so select all of the objects in the 
outline of the polyline you wish to create, 
including the object you originally selected 
when you began the Edit Polyline command.  
The command line should read “8 total”. Hit 
ENTER to join all of the entities into a 
closed shape, and then hit ESCAPE to exit 
the Edit Polyline tool.  You should now be 
able to select the entire closed polyline with 
one selection of the mouse as shown in 
Figure 7.8.   

  

Figure 7.8 – The closed polyline selected  

  
  
  

Drawing a Closed Polyline Shape to be Extruded 
________________________________________________________ 
 
Select the Polyline tool from the Draw panel and specify a starting point in the lower 
left hand corner of the graphical display to the left of the first shape. In Figure 7.9, you 
can see the actual continuous line of data you need to specify at the command line for 
this shape. 

 
Command: _pline 
Specify start point: 
Current line-width is 0.00 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:  <Ortho on> 40 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 30 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 11 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 8 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 11 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: C 
 
Figure 7.9 – The Polyline text from the command line 

 
There twelve line segments in the Polyline and the dimensions are shown in the sketch in 
Figure 7.1.  At this point you should be able to read directly from the sketch and therefore rely 
less on the step by step outline in these chapters. Such practice will improve your ability to 
read isometric drawings. 
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Figure 7.10 – The completed polyline 

  
 
 

Extruding Solids from Closed Polylines  
________________________________________________________ 
 
Only closed entities like Polylines and Circles can be extruded using this very 
powerful tool on the Modeling panel. You can extrude multiple Polylines and Circles 
at a time with the Extrude command. 
 

  

Figure 7.11 – Selecting to extrude Figure 7.12 – Two extruded polylines 
  
Select the Southwest Isometric View on the View panel as shown in Figure 7.11. Select the 
Extrude tool on the Modeling panel and the command line will prompt you to “select 
objects”. Pick the upper right of the graphical display and going to the left, you will create 
dotted selection window signifying the “crossing” option, which will select any entities that 
come in contact with the selection window. The command line will return with “2 found”. Hit 
ENTER to specify the height or path of the solid. Type “10” and ENTER for the height of 
the extrusion. Two complex 3D solids will appear in the graphical display as shown in Figure 
7.12. 
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Rotating a 3D Solid Using the 3D Rotate Command 
________________________________________________________ 
 
You can rotate the second solid on the X-axis using the 3D Rotate command. Select the 3D 
Rotate tool from the Modify panel. When prompted to “select objects”, select the second 
solid and hit ENTER and then select the midpoint Osnap of the bottom edge of the front face 
of the solid as shown in Figure 7.14. You are going to rotate the solid part on the X axis, so 
select the circle that orbits the X axis as shown in Figure 7.14. Specify an angle start point, 
and then with the Ortho mode move the cursor so that the preview outline moves 90 degrees 
as shown in Figure 7.15.  You may want to move the part back along the y-axis before 
continuing to the Align tool (Figure 7.15).  
 

  
Figure 7.14 – Selecting the axis of rotation Figure 7.15 – The rotated solid, moved 

back 
  
  
  

Align Solid Adjacent to the Master Solid 
________________________________________________________ 
 
Select the Align command by expanding the Modify panel. At the command, “select 
objects”, pick the solid on the right and hit ENTER to proceed to the second part of 
the function. Notice that this is not the 3D Align command.  

 
The Align command allows you to join the faces of two 2D or 3D objects.  In this case you 
will be joining the small 10x10 face of the right solid to the bottom corner of the front face of 
the left solid, as is evident in the sketch of this problem.  To accomplish the command you 
select six points:  three source points and three destination points.  These six points will define 
the two faces to be aligned with each other and the orientation of the source object.   
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The first source and destination points will 
end up becoming one point in the finished 
alignment.  In this case, select the bottom 
left-hand corner of the 10x10 face on the 
right solid as the first source point and then 
the bottom right-hand corner of the left solid 
as the first destination point.  These two 
points will join to become the same point 
when the alignment is finished.  Use endpoint 
Osnaps to select both, and a temporary line 
will appear on the screen showing the 
relationship of the two points (Figure 7.16).   

  

Figure 7.16 – The first alignment points  

  

The second and third set of points you select 
will not end up becoming the same point, but 
they will reside on the same respective axes.  
For the second source point, select the upper 
left-hand corner of the 10x10 face of the right 
solid.  Select the upper right-hand corner of 
the left solid as the destination point.  Again a 
temporary line will appear connecting both 
points, showing their relationship in the 
alignment (Figure 7.17).  When finished with 
the command these two points will reside on 
the same parallel line.   

  

Figure 7.17 – Second alignment points  

  

The third set of points will finalize the 
definition of the planes of the two shapes that 
you are aligning.  Select the bottom right-
hand corner of the 10x10 face of the right 
solid as the third source point.  Select the 
bottom left-hand corner of the front face of 
the left solid as the third destination point 
(Figure 7.18).   

  

Figure 7.18 – Third alignment points  
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Immediately the right solid will move and 
rotate 90 degrees, aligning its 10x10 face 
with the front face of the left solid in the 
bottom right-hand corner (Figure 7.19).  You 
may recognize the powerful nature of the 
Align command by its ability to both move 
and rotate objects with a few simple 
selections.  However, you most likely also 
discovered that the difficulty of the Align 
command lies not in its complexity as a tool 
but in properly identifying the source and 
destinations points necessary to create the 
desired alignment.  This complex technique 
will require some practice but it can be 
mastered.   
 

  

Figure 7.19 – The completed alignment  

 
 
 

Union the Solids 
________________________________________________________ 
 
Now that you have both 3D solids in place, you are ready to join to create the final 
product. You will use the Boolean command Union to create the master solid. 
 

Select the Union tool on the Solid Editing 
panel under the Home tab.  The command 
line will prompt you to “Select objects”. 
Select both solids and the command line will 
respond with “2 found”. Hit ENTER to 
combine both selected solids into one entity 
as shown in Figure 7.20. No apparent 
change will occur to the solid, but if you 
select the object with one pick of the cursor 
the entire solid will become highlighted.  

  

Figure 7.20 – The single master solid 
selected 
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Hide the 3D Solid 
________________________________________________________ 
 
To view a more realistic image of Solid Problem Six, select the Hide tool and 
the X-Ray Effect tool from the Visual Styles panel under the View tab.   
 

You will see the part as shown in Figure 7.21, 
with the visible faces and edges highlighted, 
but also the non-visible faces and edges still 
visible behind the part giving it a slightly 
transparent look.  This combination of visual 
styles allows you to see the part in a more 
lifelike manner but still see the details not 
normally apparent in an opaque solid.   

  
Figure 7.21 – The X-Ray Effect  

 
 
 

Moving the Solid to the Origin Point 
________________________________________________________ 
 
To move Problem Six to the drawing origin 
of 0,0,0 on the x, y and z axis, select the 
Move tool from the Modify panel under the 
Home tab, select the 3D solid, and hit 
ENTER.  At the prompt “specify base point 
or displacement,” select the bottom left 
endpoint Osnap as shown in Figure 7.22, 
which will become its insertion point into an 
assembly drawing.  At the “second point of 
displacement,” type 0,0,0 and ENTER, or 
#0,0,0 and ENTER if using Dynamic Input. 
Problem Six will move to the origin point.  
Moving a part at the origin is important for 
when you wish to insert the solid into an 
External Referenced Assembly drawing. 

 
Figure 7.22 – Moving the finished solid to 
the origin 
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Saving the Solid Problem 
________________________________________________________ 
 
To save Problem 6 in your Fundamentals of 3D Drawing Folder, select the Save As 
tool on the Quick Access toolbar. The Save Drawing As window will appear in your 
graphical display. In the Save In list box, select your drawing folder.  Type “Problem 
6” in the File Name textbox and hit the Save button to save the drawing (Figure 7.23). 
  

 
Figure 7.23 – Saving Problem Six 
 
* World Class CAD Challenge 03-06 * - Close this drawing file.  Create a New file and 
draw the closed Polyline, create the two details adjoining the Polyline box. Modify and 
extrude the entities, union and subtract them. Move the finished solid to the origin of the 
drawing.  Complete the task in less than 5 minutes.  Continue this drill four times, each 
time completing the drawing in less than 5 minutes to maintain your World Class 
ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
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